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Chapter 1. Introduction to the MySQL
Migration Toolkit

The MySQL Migration Toolkit is a graphical tool provided by MySQL AB for migrating schema
and data from various relational database systems to MySQL.

MySQL Migration Toolkit is designed to work with MySQL versions 5.0 and higher.

The MySQL Migration Toolkit is alpha software. While every effort has been made to ensure it is
free of bugs, it should not be used in a production environment. Always back up your data before
using the MySQL Migration Toolkit. If you find it's lacking some feature important to you, or if you
discover a bug, please use our MySQL Bug System [http://bugs.mysql.com] to request features or
report problems.
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Chapter 2. Features of the MySQL
Migration Toolkit

The following are some of the key features of the MySQL Migration Toolkit:

• The MySQL Migration Toolkit supports a variety of source database systems, including the fol-
lowing:

• Oracle

• Microsoft SQL Server

• Microsoft Access

• The MySQL Migration Toolkit is fully customizable through its Java runtime interface. Ad-
vanced users can use Java to perform custom data and schema transformations.

• The MySQL Migration Toolkit supports agent-based data migrations, with the MySQL Migra-
tion Toolkit residing on a separate machine than the source and target database servers, through
the use of a special migration agent. The agent-based data migration improves migration per-
formance by allowing data to be transferred directly from the source machine to the target ma-
chine without being router through the MySQL Migration Toolkit.
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Chapter 3. Installing MySQL Migration
Toolkit
3.1. Introduction

The MySQL Migration Toolkit is available for all recent 32-bit Windows platforms, in source and
binary forms. MySQL Migration Toolkit can be downloaded from The MySQL web site.
[http://dev.mysql.com/downloads/migration-toolkit/]

The MySQL Migration Toolkit requires the Java Runtime Environment (JRE) to run. The
JRE can be downloaded from the Sun Microsystems web site
[http://java.sun.com/j2se/1.5.0/download.jsp] (look for the JRE 5.0 section of the download
page).

3.2. Installing Under Windows
MySQL Migration Toolkit runs on recent 32-bit Windows NT based operating systems, including
Windows 2000, XP, and 2003. It doesn't run on Windows NT 4 and below.

MySQL Migration Toolkit is installed through the use of a Windows Installer (.msi) installation
package, which can be used on all recent Windows operating systems. The MSI package in con-
tained within an archive named mysql-migration-toolkit-version-al-
pha-win32.msi, where version indicates the MySQL Migration Toolkit version.

The Windows Installer system was updated with the release of Windows XP; those using an older
version of Windows can reference this Microsoft Knowledge Base article
[http://support.microsoft.com/default.aspx?scid=kb;EN-US;292539] for information on upgrading
to the latest version.

To install MySQL Migration Toolkit, right-click on the MSI file and select Install. The installation
will begin automatically after the installer prompts you for your installation preferences. During in-
stallation, you can choose whether you want the installer to place a shortcut in the Start menu and
an icon on the desktop.

If you are having problems running the installer, you can download a ZIP file without an installer as
an alternative. That file is called mysql-migration-toolkit-noinstall-version-
alpha-win32.zip. Using a ZIP program, unpack it to a directory of your choice. You may want
to create shortcuts to MySQLMigrationTool.exe for your desktop or quick launch bar.

Unless you choose otherwise, MySQL Migration Toolkit is installed in
C:\%PROGRAMFILES%\MySQL\MySQL Migration Toolkit
1.0\MySQLMigrationTool.exe, where %PROGRAMFILES% is the default directory for pro-
grams on your machine. For example, this directory might be C:\Program Files or
C:\Programme.
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Chapter 4. Starting MySQL Migration
Toolkit

Start MySQL Migration Toolkit by double-clicking its desktop icon, or by selecting its entry from
the Start menu (typically the MySQL Migration Toolkit entry of the MySQL section of the
Start menu). Alternatively, you can open a DOS window and start the MySQL Migration Toolkit
from the command line:

C:\%PROGRAMFILES%\MySQL\MySQL Migration Toolkit 1.0\MySQLMigrationTool.exe

%PROGRAMFILES% is the default directory for programs on your machine. For example,
C:\program files or C:\Programme. If your path contains spaces, you should enclose the
command within double quotes. For example:

C:\> "C:\Program Files\MySQL\MySQL Migration Toolkit 1.0\MySQLMigrationTool.exe"
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Chapter 5. An Overview of the
Migration Process

The MySQL Migration Toolkit uses an eight-step process to migrate data from an external RDBMS
to MySQL:

Figure 5.1. The MySQL Migration Toolkit Migration Plan
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• Source/Target Selection: In the first step you specify the connection parameters for
the source and target database servers.

• Object Selection: In the second step you select the objects (tables, views, stored proced-

An Overview of the Migration Process
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ures) that will be migrated.

• Object Mapping: In the third step you choose the method used for mapping and transform-
ing the objects.

• Manual Editing: In the fourth step you can manually edit the new objects to ensure a proper
transformation.

• Schema Creation: In the fifth step the MySQL Migration Toolkit creates the transformed
object on the target MySQL server.

• Data Mapping: In the sixth step you specify any changes that need to be made to the data as
it is migrated.

• Bulk Transfer: In the seventh step the MySQL Migration Toolkit transfers the data from
the source server to the target server.

• Summary: In the eighth and final step the MySQL Migration Toolkit creates a summary report
of the migration process for you to review.

Each of these sections will be covered in more detail in the coming chapters.

An Overview of the Migration Process
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Chapter 6. The Migration Process
In-Depth
6.1. Introduction

In this chapter we will cover the different steps of the MySQL Migration Toolkit in depth. The dif-
ferent steps will be covered in the order that they appear in the MySQL Migration Toolkit.

6.2. The Welcome Screen
The first screen of the MySQL Migration Toolkit is the Welcome Screen:

Figure 6.1. The MySQL Migration Toolkit welcome screen

The welcome screen indicates the progress of loading the various components of the MySQL Migra-
tion Toolkit. If you encounter any errors on the welcome screen you should close the MySQL Mi-
gration Toolkit and confirm that you have properly installed the Java Runtime Environment. See
Section 3.1, “Introduction” for information on downloading and installing the Java Runtime Envir-
onment.

6.3. The Configuration Type Screen
The Configuration Type screen allows you to choose between a Direct Migration and a Agent-Based
Migration:
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Figure 6.2. The Configuration Type screen

Use the Direct Migration if the MySQL Migration Toolkit is installed on either the source or
target machine. The Direct Migration should not be used when the MySQL Migration Toolkit is not
located on either the source or target machine, as it will create a large amount of network traffic and
will result in decreased performance.

Use the Agent-Based Migration when migrating between two server machines that do not
support the use of the MySQL Migration Toolkit. The MySQL Migration agent should be installed
on the source machine before using the Agent-Based Migration.

6.4. The Source Database Screen
Use the Source Database screen to select the source RDBMS used in the migration and to specify
the connection parameters.

The Source Database screen's appearance will vary depending on the type of source database selec-
ted.

All Data Source screens will feature a Details button that can be used to expose the Advanced Set-
tings panel. The Advanced Settings panel can be used to manually specify a JDBC driver and JDBC
connection string for your migration session.

6.4.1. Microsoft Access
The Source Database screen appears as follows when you select Microsoft Access as the source
database:

The Migration Process In-Depth
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Figure 6.3. Source database - Microsoft Access

Specify the path to the .mdb database file in the Database File field and specify the database
username and password information if applicable.

You must make special modifications to your Access database file before it can be used with MySQL
Migration Toolkit. Please see Appendix A, Preparing a Microsoft Access Database for Migration
for further information.

6.4.2. Microsoft SQL Server
The Source Database screen appears as follows when you select MS SQL Server as the source
database:

Figure 6.4. Source database - Microsoft SQL Server

The Migration Process In-Depth
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Specify the hostname, username, and password to connect to the source Microsoft SQL Server to
connect and click Next.

6.4.3. Oracle
The Source Database screen appears as follows when you select Oracle as the source database:

Figure 6.5. Source database - Oracle

The Migration Process In-Depth
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If you encounter the following database selection screen, it means that you do not have the appropri-
ate JDBC driver for Oracle installed:

Figure 6.6. Oracle JDBC driver not attached

The Migration Process In-Depth
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If the Oracle JDBC driver is present on your system, click the Locate JDBC Driver on Harddisk but-
ton to attach the driver.

If the Oracle JDBC driver is not present on your system, click the Download JDBC Driver from the
Web button to download it. Download the ojdbc14.jar file and then attach it by clicking on the
Locate JDBC Driver on Harddisk button.

After attaching the Oracle JDBC driver you need to restart the MySQL Migration Toolkit.

6.4.4. MySQL
The Source Database screen appears as follows when you select MySQL as the source database:

Figure 6.7. Source database - MySQL

The Migration Process In-Depth
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6.4.5. Saving Connection Information
After entering the connection information for the source database, click the + button to save the con-
nection information.

When prompted, enter a name for the connection information and click the Ok button to save the
connection information for later re-use.

You can discard saved connection information by selecting the saved connection from the Connec-
tion drop-down list and clicking the - button.

6.5. The Target Database Screen
Use the Target Database screen to select the target RDBMS used in the migration and to specify the
connection parameters.

The target Database screen uses an interface that is identical to that of the Source Database screen:

Figure 6.8. Target Database - MySQL

The Migration Process In-Depth
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Target database support for the MySQL Migration Toolkit is currently limited to MySQL 4.1 and
MySQL 5.0.

6.6. The Connect to Server Screen
After you specify your source and target database servers, the MySQL Migration Toolkit will con-
nect to each server and retrieve the schema information from the source server:

Figure 6.9. The Connect to Servers screen

The Migration Process In-Depth
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Click the Details button to see a more detailed log of the connection process.

6.7. The Source Schema Selection Screen
Use the Source Schema Selection screen to choose which databases from the source server you
would like to migrate.

If there are a large number of databases to choose from, you can search for a specific database by
entering the database na,e in the

Figure 6.10. The Source Schema Selection screen

The Migration Process In-Depth
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6.8. The Reverse Engineering Screen
Once you select the databases you wish to migrate, the MySQL Migration Toolkit begins the pro-
cess of reverse engineering the source database:

Figure 6.11. The Reverse Engineering screen

The Migration Process In-Depth
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The MySQL Migration Toolkit collects column and index information for each table in the source
database, along with information on stored procedures and views.

Click the Details button to see a detailed log of the reverse engineering process.

6.9. The Object Type Selection Screen
Use the Object Type Selection screen to choose which objects you wish to migrate:

Figure 6.12. The Object Type Selection screen

The Migration Process In-Depth
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Check the box next to the objects types (Tables, Views, Stored Procedures) that you wish to mi-
grate.

6.9.1. Migrating a Sub-Set of an Object Type
If you only wish to a sub-set of the available object types, click the Detailed Selection button next to
the object type:

Figure 6.13. The detail view of the Object Type Selection screen

The Migration Process In-Depth
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The objects in the left window will be migrated. To ignore an object, select it and click the > button.
To move an object out of the ignore list, select it and click the < button.

To exclude objects based on pattern matching, click the + button:

Figure 6.14. The Add Ignore Pattern dialog

Patterns can include the * and ? characters, with * representing multiple characters (including no
characters at all) and ? representing a single character.

6.10. The Object Mapping Screen
Use the Object Mapping screen to configure the methods used to migrate the database objects to
MySQL. The MySQL Migration Toolkit comes with multiple migration methods that can be used to
convert the database objects of an external RDBMS to MySQL.

In most cases the default settings will be adequate.

There are four areas of migration to be addressed: GRT Object, Table, View, and Stored Procedures:

Figure 6.15. The Object Mapping screen

The Migration Process In-Depth
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6.10.1. GRT Object
The GRT Object section of the Object Mapping screen dictates the properties of the database itself.
By default a generic profile is used, with a Latin1 character set.

To modify the character set used on the database level, click the Set Parameter button. Choose from
Latin1, Multilanguage, or User defined.

6.10.2. Table Objects
The Table section of the Object Mapping screen dictates the properties of the individual tables. By
default a generic profile is used, with an InnoDB storage engine.

To modify the storage engine used with the migrated tables, click the Set Parameter button. Choose
the Data consistency option to use the InnoDB storage engine for transactional and foreign
key support. Choose the Statistical data option to use the MyISAM storage engine with in-
creased performance but no transaction safety. Choose the Data consistency / multil-
anguage option to use the InnoDB storage engine with UTF8 as the default charset. If none of the
provided options meet your needs, choose the User defined option and provide your
own settings.

6.11. The Meta Migration Screen
After you configure data object mapping, the MySQL Migration Toolkit performs the conversion of
the database objects and generates SQL CREATE statements.

Figure 6.16. The Meta Migration screen

The Migration Process In-Depth
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The SQL CREATE statements are not executed on the target server at this stage of the migration, but
will be executed later.

Click the Details button to view a detailed log of this stage of the migration process.

6.12. The Manual Editing Screen
Use the Manual Editing screen to review the SQL CREATE statements generated by the MySQL
Migration Toolkit:

Figure 6.17. The Manual Editing screen

The Migration Process In-Depth

22



By default only objects that were not successfully converted are displayed in the Manual Editing
screen. To view all objects select the Show All Objects entry of the Filter drop-down list. Choose
the Show All Objects with Messages entry of the Filter drop-down list to view all object with status
messages.

To edit the SQL CREATE statements created by the MySQL Migration Toolkit, select the object and
click the Details button:

Figure 6.18. The Manual Editing screen - detailed view

The Migration Process In-Depth
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Make changes to the CREATE statement and click the Apply Changes button. If you make a mistake
while editing, click the Discard Changes button to revert the CREATE statement.

6.13. The Object Creation Options Screen
After performing manual object editing the MySQL Migration Toolkit is ready to create the data-
base objects on the target server. You have the option of either creating the database objects directly
on the target server or to create a script file of the CREATE statements for later execution:

Figure 6.19. The Object Creation Options screen

The Migration Process In-Depth
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Select both options to create the target database objects and preserve a backup copy of the CREATE
statements for later use.

6.14. The Creating Objects Screen
Once you choose object creation objects, the MySQL Migration Toolkit connects to the target server
and creates the database objects (assuming you chose to have the MySQL Migration Toolkit connect
to the target server to create the database objects). If you chose to have a copy of the CREATE state-
ments saved to disk this will be performed at this time.

Figure 6.20. The Creating Objects screen

The Migration Process In-Depth
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Click the Details button to view a detailed log of this stage of the migration process.

6.15. The Data Mapping Options Screen
After the database objects are created on the target database server the MySQL Migration Toolkit is
ready to move the server data to the target server. You have the option of either inserting the data
directly on the target server or to create a script file of the INSERT statements for later execution:

Figure 6.21. The Data Mapping Options screen

The Migration Process In-Depth
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Select both options to move the data and preserve a backup copy of the INSERT statements for later
use.

You can access additional options by clicking the Details button. If you do not wish to move BLOB
data to the target server, check the box next to the Exclude BLOB values option. The BLOB data
will not be moved to the target server and will not be written to the script file. If you do not wish to
move BLOB data to the target server, but wish to have the BLOB data written to the script file, also
check the box next to the Write BLOBs to Insert Script option.

If you wish to limit the number of rows transferred to the target server, check the box next to the
Maximum Numbers of Rows to Transfer for a Table option and enter the desired number of rows.
This option can be useful when generating test data.

6.16. The Bulk Data Transfer Screen
Once the data mapping options are set, the MySQL Migration Toolkit will begin the bulk data trans-
fer process. Data will be converted to a MySQL compatible format and inserted into the target data-
base server using bulk INSERT statements. Data is typically inserted in batches of 15,000 rows at a
time to maximize insertion speed.

Figure 6.22. The Bulk Data Transfer screen

The Migration Process In-Depth
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Click the Details button to view a detailed log of this stage of the migration process.

6.17. The Summary Screen
Once the bulk data transfer is complete, a summary report of the migration will be displayed:

Figure 6.23. The Summary screen

The Migration Process In-Depth
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Click the Finish button to exit the MySQL Migration Toolkit.

6.18. Saving the Current Application State
If you need to close the MySQL Migration Toolkit part way through the migration process, you can
save the state of the MySQL Migration Toolkit to disk and continue later.

To save the current state of the MySQL Migration Toolkit, choose the Store current application state
option of the File menu.

To later retrieve the application state and resume configuring the migration, choose the Reload
stored application state option of the File menu.

The Migration Process In-Depth
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Chapter 7. Extending The MySQL
Migration Toolkit
7.1. Introduction

One of the key features of the MySQL Migration Toolkit is that it can be easily extended and cus-
tomized to support new data sources. Through the use of its Generic RunTime Environment (GRT),
the MySQL Migration Toolkit can support new behaviour and data sources using code written in
languages such as Java, PHP, and C.

Extending the MySQL Migration Toolkit to support a new RDBMS requires the creation of two
new modules: one module that reverse engineers (ie., retrieves schema information) the source data-
base objects and converts them into GRT objects, and one module that migrates the source GRT ob-
jects into MySQL GRT objects. The MySQL Migration Toolkit then converts the GRT MySQL ob-
jects into SQL statements that create the the target MySQL server objects.

Existing modules can be easily expanded and customzed to achieve the perfect migration for indi-
vidual requirements. New migration "methods" that define how the migration is performed can be
added easily. The new methods are listed and can be selected by the end user in the Wizard interface
or used in migration scripts.

7.2. Architecture of the MySQL Migration
Toolkit

The MySQL Migration Toolkit is written on top of the Generic Runtime Environment (GRT): a thin
C layer, inspired by Objective C, which allows for dynamic typing and dynamic data objects. The
GRT supports the creation of new modules written in C, Java, PHP, and Lua, with support for Py-
thon and Mono forthcoming.

The MySQL Migration Toolkit is built on three primary modules: reverse engineer modules, migra-
tion modules, and transformation modules.

Reverse engineering modules retreive the schema information from the source database and return
GRT objects that describe the schema. Reverse engineering modules will have a name similar to
ReverseEngineeringAccess.

Migration modules convert the source database GRT objects to MySQL GRT objects and then
handle the bulk data transfer between the source and MySQL databases. Migration modules will
have a name similar to MigrationAccess.

Transformation modules convert the MySQL GRT objects into the actual SQL statements used to
create objects such as tables and views on the target MySQL server. Transformation modules will
have a name similar to TransformationMySQL. Transformation modules are supplied by the
MySQL GUI team and need not be created to add support for a new source database.

All modules are derived from base classes whose methods can be re-written to match the new source
database.

7.3. The Modular Migration Process
From a module developer point of view, the migration process is as follows:

1. The MySQL Migration Toolkit prompts the user for a source database and connection paramet-
ers. The user selection determines which modules will be used for the source database.
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2. The MySQL Migration Toolkit calls the testConnection method of the reverse engineer-
ing module. The testConnection method returns success or failure to the MySQL Migra-
tion Toolkit.

3. The MySQL Migration Toolkit calls the getSchemata method of the reverse engineering
module. The getSchemata method returns a list of the schemas available on the source RD-
BMS for the user to choose from.

4. Once the user has selected one or more schema to migrate, the MySQL Migration Toolkit calls
the reverseEngineer method of the reverse engineering module. The reverseEngin-
eer method converts all objects in the source RDBMS (tables, views, procedures) into a col-
lection of GRT objects.

5. After the source database has been reverse engineered, the MySQL Migration Toolkit calls the
migrationMethods method of the migration module. The migrationMethods method
generates a list of available methods than can be selected by the user in the Object Mapping
Screen.

6. Once the user has selected the migration methods, the MySQL Migration Toolkit calls the mi-
grate method of the migration module. The migrate method converts the source RDBMS
GRT objects into MySQL GRT objects by calling the selected migration method for each
source schema object. If no explicit method is assigned, the default migration method for the
object type will be used.

7. After the MySQL GRT objects have been created, the MySQL Migration Toolkit calls the
transformation moldule to convert the MySQL GRT objects into SQL statements that will cre-
ate the objects on the target MySQL server. The MySQL Migration Toolkit then either ex-
ecutes the SQL statements on the target MySQL server or writes them to a script file.

8. In the final step, the MySQL Migration Toolkit calls the dataBulkTransfer method of the
migration module. The dataBulkTransfer method loops through the selected tables in the
selected schema and migrates the rows of the tables to the target MySQL database or loads
them into a script file, depending on the user preference.

7.4. Tools Required to Extend the MySQL Mi-
gration Toolkit

The MySQL AB GUI Team uses Eclipse for development of the MySQL Migration Toolkit mod-
ules and recommends Elcipse for use when developing modules for the MySQL Migration Toolkit.
See http://www.eclipse.org/ for more information.

Extending The MySQL Migration Toolkit
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Appendix A. Preparing a Microsoft
Access Database for Migration

The MySQL Migration Toolkit requires access to the system tables of a Microsoft Access database
for the purpose of reverse-engineering. By default, read access to the system tables of an Access
database is restricted for external applications.

To enable access to the system tables by the MySQL Migration Toolkit, open the database in Mi-
crosoft Access and choose the Options entry of the Tools menu. Within the Options dialog, select
the View tab and look for the Show section:

Figure A.1. The show section

Check the box next to the System objects option and close the options dialog. System tables for the
database should now be present:

Figure A.2. The system objects

Note the presence of the various MSys tables.

After you expose the system objects to the MySQL Migration Toolkit, you must also grant permis-
sion to access the objects. Choose the User and Group Permissions entry from the Security section
of the Tools menu:
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Figure A.3. Granting access to the system objects

Enable the Administer permission for both the MSysObjects and MSysQueries tables. You
will need to click the Apply button after enabling each table and before moving to the next table.

After completing these steps, you can reverse-engineer the schema in your Access database using
the MySQL Migration Toolkit.

Preparing a Microsoft Access Database for
Migration
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